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Getting started

Getting started
This chapter explains how to install the Meridian Configuration Program, and gives a general
overview of its key features.

Overview

single configuration file representing the settings of each product in

The Meridian Configuration Program is a Windows application that

in the controller of the system for future reference. As well as being

lets you design the configuration of your G Series or 800 Series

far more convenient than configuring each product independently,

products to suit both your own personal preferences and the

this approach also enables the Meridian Configuration Program to

particular configuration of other equipment in your system.

check that the settings you are proposing are appropriate for the

your system and the way they are interconnected. This file is stored

particular combination of products in the system.
It uses an intuitive graphical interface that prompts you at every
stage for the information it needs to complete the system. When

The Meridian Configuration Program is structured as a wizard;

you have designed the system to your requirements you can save

it leads you through a series of stages from the Welcome

the configuration to the appropriate Meridian products in the

page through to the Finish page, which is reached when the

system via a serial link connected to the back of each product.

configuration has been completed. A Breadcrumb Trail below the
toolbar at the top of the Meridian Configuration Program

How it works

window shows your current position in the sequence of pages and

The Meridian Configuration Program reflects Meridian’s system

allows you to jump back to an earlier page to check a particular

approach to designing audio products and presents a graphical

setting you made.

representation of your whole system. It allows you to create a
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Benefits of using the Meridian
Configuration Program

Meridian Control Window

Configuring your system with the Meridian Configuration Program

Control Window utility, a separate PC application that allows you

offers several important benefits. In particular:

to control any Meridian product via a serial cable (or USB cable

The Meridian Configuration Program is supplied with the Meridian

on certain products) using a simple push button interface that
• You can configure the entire system in a single operation.

emulates a Meridian MSR+ or MSR remote control. Alternatively it

• It is more convenient and more intuitive than using the front-

allows you to submit commands by name, and supply parameters

panel menus.
• You have access to many advanced configuration options that are
not available from the front-panel menu.
• You can conveniently edit the names of sources, DSP presets, and
radio presets using the keyboard.
• You can edit the G Series soft keys.
• If your controller is a G68 or 861 you can take advantage of
Meridian Room Correction.
• You can set up multiple systems far more conveniently than by
manually configuring each product.
• You can keep a record of the configuration of your entire system
in a single document on your PC.
If you have made manual adjustments to the configuration of
a product from the front panel, you can fetch the product’s
configuration into the Meridian Configuration Program as the
starting point for the configuration of your system, in order to
retain the settings, such as calibration settings.

for commands that take a value, such as the volume setting.
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The Products page
The following illustration shows the key features of the Products
page, which lets you specify how your system is interconnected:

Toolbar
Breadcrumb Trail
Information Bar

Tabs to add new products

Resource Bar

Sources

Speakers
Controller
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Installing the Meridian Configuration Program
Requirements
To use the Meridian Configuration Program you need:
• A computer running Windows 95, 98, 2000, NT 4, ME, or XP.
• 10Mbytes of free disk space.
The Meridian Configuration Program communicates with the
products you are setting up via a serial cable. The computer you are
using needs to have a nine-pin serial port available, or you can use
a USB/serial adaptor.
Alternatively some G Series products include a USB port, in which
case the Meridian Configuration Program can communicate with
them via a USB cable connected to the computer’s USB port.
The software requires a mouse or similar pointing device – it
cannot be operated solely from the keyboard.
To install the Meridian Configuration Program
• Insert the Meridian Configuration Program Installation CD-ROM.
The Setup program should run automatically when the CD-ROM is
inserted. If not, locate setup.exe on the CD-ROM and run it.
The Setup program Welcome page will be displayed.
• Follow the wizard.

On the Preferences page:
• Leave Install for all users selected, unless you want to restrict
use of the program to yourself on a multi-user machine.
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Quick tour
This section gives complete step-by-step instructions for creating a complete configuration for
a typical simple system. Even if this does not correspond to your own system we recommend
you follow the tutorial to give you a quick tour of the Meridian Configuration Program.
At each stage the Quick tour shows information in grey tinted boxes about the more advanced
features of the program, and the additional options for configuring 800 Series products.

Running the Configuration
Program
• Click Start, point at All Programs, Meridian, then click
Configuration Program:

Using the Meridian Configuration
Program
The simplest way to use the Meridian Configuration Program is to
click the links in the Breadcrumb Trail and Information Bar at the
top of the window; for example:

The Breadcrumb Trail shows a sequence of hyperlinks to pages you
have already visited; this is indicated by the blue underline. Clicking
one of the links takes you to the corresponding page to allow you
to check your settings on that page, or make changes. The last
entry on the Breadcrumb Trail is usually Next, which takes you to
the next page.
The Information Bar provides help about the current page, and
tells you what to do next. The Information Bar contains two types
of hyperlink: definitions, prefixed by a question mark icon, which
display a pop-up window with a definition of the item, and jumps,
The Welcome page will be displayed. This provides links to useful

prefixed by an arrow icon, which perform an action or jump to

information.

another page.

6

Quick tour

Starting a configuration
To start creating a configuration from the Welcome page:
• Click the Next link in the Breadcrumb Trail:

The Products page will then be displayed. This allows you to
define the products in your system and indicate how they are
connected together.

Getting help
For more detailed information about the Meridian Configuration
Program see the on-line help. To display the help:
• On the Help menu, click Configuration Program Help.
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Products: Adding a controller

Quick tour

The controller is defined as the product that selects sources and

The Products page will then show a block representing the

controls the volume for the system; it is the digital surround

G68ADV Digital Surround Controller:

controller, preamplifier, or combination product. In this example it is
a G68 Digital Surround Controller.
• Click the insert a controller link in the Information Bar.
An Insert dialogue box is displayed to allow you to specify the
type of controller.
• Select G68ADV from the drop-down list and click the OK button
to add the product:

You will then be asked whether you want to fetch an existing
configuration from the controller. If you are starting from scratch, as
in this Quick tour, you do not need to do this. For more information
see the Advanced tips on the next page.
• Click the No button to indicate that you do not want to fetch
data from the digital surround controller:
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Advanced tips
Adding products by dragging them from the Resource Bar
The most flexible way of adding products is to drag an appropriate
icon from the Resource Bar (to the left of the Products page)
onto the Products page:

For example, to delete a product:
• Right-click the product, then click Delete on the context menu.
Note: If you delete the controller you will need to restart the
configuration from scratch.
Displaying or changing product properties
Many products provide a range of properties that you can change
for specific situations. To display the product properties:
• Right-click the product, then click Properties on the context
menu, or double-click the product.

Fetching settings from a product
If you have changed any settings on a product from the front

The Properties dialogue box shows a list of the properties

panel since making a previous configuration, you can retain the

associated with the product, and allows you to view or change

settings by using the Meridian Configuration Program to fetch the

their values:

configuration from the product, rather than starting from a default
configuration as described above. This is also useful if you cannot
locate the file on the computer.
• Connect a serial cable between the product and your PC, as
described in To connect the serial cable, page 23.
• When the Fetch from Product dialogue box is displayed click
the Yes button.
Performing other actions
Right-clicking on most objects on the Products page displays a
context menu of actions appropriate to that object:
For detailed information about each of the properties refer to the

Configuration chapter in the Installation Guide for the product,
or the FAQs section in the on-line help. To display this click
Configuration Program Help on the Help menu.
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Changing the value of a property
• Click the value of the property.
• Choose an option from the drop-down list:

Configuring 800 Series products
Adding an 800 Series controller
If you are adding an 800 Series controller a dialogue box will allow
you to specify one of the product’s standard card configurations.
Alternatively select Minimal to add a minimum set of cards at this
stage, in which case you will be prompted to add further cards as

If it is a numeric property you will get a spin button rather than a

you make connections to the product:

drop-down list:

If it is an on/off property you can click the checkbox to change the
value:

If you have changed the value of a property an asterisk (*) is
shown after its name.
Adding cards
Reverting a property to its default value

You will be automatically prompted to add cards as required

• Right-click the property, then click Revert to Default on the

when you add sources or speakers to the 800 Series product.

context menu:

The menu option shows the default value.

Alternatively you can add cards explicitly if you prefer:

Either:
• Drag the appropriate card icon from the 861 Cards or 800
Cards tab in the Resource Bar (to the left of the Products
page).
Or:
• Right-click the product icon, then click Add Card… on the
context menu:
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The following dialogue box allows you to specify the card type and,

Initially this shows a graphic of the card positions:

when appropriate, the position of the jumper identifying the card:

Removing a card
• Right-click one of the outputs on the card, then click Remove
Card on the context menu.
Displaying the properties of a card

To show a list of the cards:

• Right-click one of the outputs on the card, then click the
Properties item on the context menu.

• Right-click, then click Details on the context menu:

A Properties dialogue box shows information about the type of
card, its slot positions, and the jumper setting:
This shows a list of the installed cards:

Displaying information about the cards
• In the Properties dialogue box click the Cards tab.
You can also add a card, remove a card, or display a card’s
properties in the Graphic or Details view by right-clicking, then
clicking Properties on the context menu.
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Quick tour

The next step is to add the sources in your system. For this Quick

The Meridian Configuration Program will use a set of connections

tour we will assume a satellite receiver is required.

which match the back panel screening of the controller to make
wiring up straightforward

• Click the insert a source link in the Information Bar.
• Click the Finish button to make the recommended connections.
The connections will be displayed on the Products page:
An Insert Source dialogue box is displayed to allow you to select
the type of source.
• Choose Satellite from the drop-down list, and click the OK
button to add the source:

The Connection Wizard is then displayed to assist you in
connecting the source to your other equipment:

This shows the audio connection between the satellite receiver
optical output and the optical input O1 on the digital surround
controller, and the S-video and component video connections
between the satellite receiver and the digital surround controller.
You can now proceed to add the other sources in your system in a
similar way. In this example we are only inserting a single source.
See the Advanced tips on the next page for information about
• Leave Yes selected to make the recommended connections
between the source and the controller.

modifying these connections; eg to use analogue rather than
optical for audio.
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Advanced tips
Showing a list of the recommended connections
• Click the Details… button in the Connection Wizard dialogue
box.
This shows the connections that will be made if you choose the

Renaming a source
You can give each source a name of up to five characters to
identify it on the front-panel display:
• Right-click the source, then click Rename… on the context
menu:

Yes (recommended) option:

The following dialogue box allows you to enter a new name:
Specifying connections manually
• Choose the No (advanced) option in the Connection Wizard
dialogue box.
• Click the Next button to continue.
• Specify each connection that you want to make from the source
to the controller, using the From: and To: drop down lists, then

Changing the MSR+ key for a source

click the Connect button to make the connection:

You can choose which MSR+ key selects each source:
• Right-click the source, then click Properties on the context
menu.
• Click the Identification tab in the Properties dialogue box.

• Click the Finish button to close the Connection Wizard
dialogue box.
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• Choose the MSR+ key from the MSR+ key drop-down list:

• Drag between the output on the source and the input on the
controller that you want to connect:

When you release the mouse button the cable will be connected:

Showing and hiding connections
You can choose whether or not source connections are displayed

If the connectors are incompatible a stop cursor will be displayed:

by clicking the View or Hide Source Connections button in the
toolbar:

Displaying information about the style of each
connection line
• On the View menu, click Legend.

Removing a connection
• Drag from one of the connectors and release the mouse button:

Connecting using drag and drop
You can also connect between any two compatible connectors
using drag and drop:

The cable connecting the two products will be removed.
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Making a multichannel connection

Adding or removing inputs or outputs

If you are connecting a product with multichannel outputs, such

With non-Meridian sources you can add new inputs or outputs,

as a G98DH DVD Player, to a digital surround controller with

or remove inputs or outputs, to reflect the connectors provided by

multichannel inputs, the Meridian Configuration Program can

your source. For example, if your satellite receiver includes a digital

create a multichannel configuration when you drag between two

coax output you can add a connector for this:

appropriate connectors:
• Right-click one of the source’s existing connectors, point to
Connection on the context menu, then click New… on the
submenu:

A prompt allows you to choose whether to make a single or

The Add Connector dialogue box allows you to define the new

multichannel connection.

connector.

If you choose Yes the multichannel connection will automatically

• Specify the type of connector using the Class and Type drop-

be made:

down list, enter a name, and choose Output or Input as
appropriate:

• Click the OK button to add the connector.
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The next step is to add the speakers in your system.

Quick tour
• Click the insert a speaker link again and select DSP5500HC
from the Type drop-down list to add a centre speaker:

• Click the insert a speaker link in the Information Bar.
The Insert Speaker dialogue box allows you to select which type
of speaker you want to add, and the positions in which to add it.
• Select DSP8000 from the Type drop-down list.

The program will offer to add a 511 patch box to the layout to
connect the Comms cables for the speakers:

The Location will automatically be set to Front left/right:

• Click the OK button to add the speakers.

• Click the Yes button to confirm.
• Click the insert a speaker link again and click Analogue

The speakers will be added to the appropriate points in the layout,

(passive) on the Type drop-down list to add small analogue

and the connections will automatically be made between the

rear speakers:

speakers and the controller:

• Click the OK button to add the speakers.
The Meridian Configuration Program will automatically prompt you
to add an amplifier to the layout to drive the passive speakers:
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• Click the Yes button.

Finally insert a subwoofer into the layout:

• Click G57 on the Amplifier type drop-down list, and click the
OK button to add the amplifier:

• Click the insert a speaker link in the Information Bar and select
Subwoofer from the Type drop-down list:

The G57 will automatically be connected up to the appropriate
analogue output on the digital surround controller:

You can proceed to add any other speakers in your layout in a
similar way.
• Click the Next link in the Breadcrumb Trail to proceed to the
next page.

17

Quick tour

Advanced tips
Adding a speaker by dragging it from the Resource Bar

The Speaker connections and Controller connections pages
will appear in the Breadcrumb Trail after the Soft keys page:

• Drag an icon from the Speakers tab of the Resource Bar (to the
left of the Products page):

Displaying or changing the speaker properties
• Drop it onto the appropriate speaker position.

To display the speaker properties right-click the speaker symbol,
then click Properties on the context menu, or double-click the

Adding a speaker at a specific position

speaker symbol:

• Right-click the position, point to Insert on the context menu,
then click Speaker… on the submenu:

Alternatively, double-click or right-click the speaker position.
Reviewing and printing the source and speaker
connections
Additional Speaker connections and Controller connections
pages can be displayed to allow you to check the source and
speaker connections, or print out a copy for help in wiring up the
system.
• On the View menu, click Review Pages.

You can edit the properties in the same way as for source
properties.
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Soft keys
The Soft keys page allows you to customise the soft keys for each
of the G Series products in the system, starting with the controller.
In this example the only applicable product is the G68ADV.
An initial recommended layout is provided for each product; for
example, for a G68 this provides soft keys for each of the sources
in the system, plus a DSP key in the rightmost position.
• Click the Next link in the Breadcrumb Trail to proceed to the
next page.
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Advanced tips
Changing the soft key layout
• Drag a soft key, or pair of keys, from the left-hand pane onto the

Renaming a source
• Right-click a soft key corresponding to a source, then click
Rename Source… on the context menu:

set of soft keys you want to edit:
All occurrences of the source in the soft key sets will be changed.
Clearing a soft key
• Right-click the soft key, then click Remove on the context menu:

Restoring the recommended layout
• Hold down c to insert the key(s), moving existing keys right to
make space.
You can undo or redo changes to the soft key layout by clicking the
Undo or Redo buttons in the toolbar:

The first 12 soft keys correspond to the 12 MSR+ keys. Only the
ones corresponding to the sources you have defined in your system
will be available – the others will be greyed out. Their names will
reflect the names you have given to the sources on the Products
page.
Soft keys that work in pairs, such as balance, bass, treble, and
bright, automatically occupy two adjacent soft key positions.

• Click the Reset button for a recommended assignment of soft
keys.
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Bass management
The Bass management page specifies how bass is handled in
the system for each of the three speaker layouts. The settings are

• Click the Next link in the Breadcrumb Trail to proceed to the
next page.

automatically set to recommended values and can be ignored for a
simple configuration.

Advanced tips
Meridian digital surround controllers allow you to define three
different speaker layouts for use with different types of material:
Music, Logic, and 5.1 Movie. The Bass management page
allows you to specify how the bass is handled in each speaker
layout:

You can choose whether the main front and centre speakers are
specified as Large or Small for each of the Music, Logic, and
5.1 Movie speaker layouts.
The diagram to the right of each tab represents the selected
speaker layout; select Display bass flow to display red arrows on
the diagram indicating how the bass for each channel is handled by
the speakers in the layout for either Multichannel or 2-channel
sources as specified (see below).
Specifying which subwoofers are used in the layout
In the Subwoofers section you can specify how many of the
subwoofers are used in the layout. Subwoofers used in the
layout are indicated by a black square in the layout diagram, and
subwoofers not in use are indicated by a white square.
If there are no subwoofers in the layout the front speakers must
be specified as Large, and they will handle the bass for any other
small speakers in the layout.

Specifying which speakers should handle the bass
The Main speakers and Surround speakers sections allow you
to specify whether each speaker is Large, in which case it will
handle the bass for that channel, or Small, in which case the bass
for that channel will be redirected to another speaker.
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If there is one subwoofer in the layout, and you have specified the

The LFE low pass filter option sets the low-pass filter for the LFE

front speakers as Small, the subwoofer will be used for the bass

channel, for the Music and 5.1 Movie speaker layouts.

and LFE. If the front speakers are Large and the centre speaker is
Small, the Front subwoofer option allows you to choose from

• Click the Reset button to reset the crossover and low-pass filter
to recommended values in all layouts.

the following options:
Option

Use of subwoofer

Specifying the THX settings

LFE Only *

Handles just the LFE.

The THX settings tab allows you to specify that your subwoofers

Bass-neutral (centre)

Handles all the bass.

are THX Ultra2 approved, and select Boundary gain

Shares the bass with the front

compensation to reduce bass levels if listeners are close to a

Bass-heavy (mono)

speakers.

wall. Click the THX Defaults button to set the crossover and lowpass filter to 80Hz in all layouts, as recommended by THX.

* Not available for the Logic layout.
If the layout includes two or more subwoofers, the subwoofers will
handle the bass and LFE for the system irrespective of the size of
the front speakers.
Specifying the crossover settings
For each speaker layout the Crossover option allows you to set
the crossover frequency for the subwoofers. This is ignored if the
subwoofers are only handling the LFE.
The Meridian digital surround controllers provide very high-quality
crossovers for the subwoofers, and for best results you should
use these instead of the subwoofer’s crossover. To do this set the
subwoofer Width property to Narrow, and remove any crossover
in the subwoofer, or set it to the highest setting (eg 200Hz). If
you cannot do this, set the subwoofer Width property to Wide to
switch off the digital surround controller’s crossover and use Sine/
Sub mode to match the subwoofer’s crossover frequency.
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Speaker distances
The Speaker distances page gathers information about the
relative positions of the full-range speakers in your system, and the
distance of each speaker from the listening position. First choose
the units you would like to work in.
• On the View menu, click Metric or Imperial.
• Measure the distance to each speaker in the specified units.
• Drag the speakers until they are in the correct positions, with the
correct distance shown on each speaker icon.
This information is used to calculate the speaker delays, and
generate the aspect ratio and rear speaker separation.
• Click the Next link in the Breadcrumb Trail to proceed to the
next page.

Advanced tips
• Click the A or V buttons to the left of the scale indicator to
change the scale of the whole diagram.
• Click a speaker to select it, and then use the arrow keys to move
the speaker in the corresponding direction.
• Use c^ and cV to move a speaker away from or
towards the listening position. Hold down S to move all the
speakers at once.
• Use c< and c> to move a speaker in a circle around the
listening position.
• Click the Scale to Fit button to increase the scale so the
loudspeakers fit neatly in the window.
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Quick tour

The Speaker calibration page allows you to calibrate the

The Meridian Configuration Program stores the settings you

speakers attached to your controller while listening to the product.

have created to the controller and then automatically starts the

You can use the Meridian Configuration Program to step between

calibration sequence so you can tune your speakers by ear using a

speakers, and change the properties of the currently selected

series of listening tests:

speaker, using the on-screen buttons.
To connect the serial cable
• Connect one end to the RS232 connector on the back panel of
the controller in your system.
• Connect the other end to one of the serial ports on your
computer.
The default is COM1. If you have to use a different port see

Advanced tips overleaf.
The Speaker calibration page shows a list of the speakers
connected to your controller and the current distance, level, and
phase settings of each speaker:

• Use the <, >, A, and V buttons on the Speaker calibration
page to control the product; refer to the appropriate guide for
your product for details of the calibration procedure.
The product’s display is shown above the arrow keys on the
Speaker calibration page.
• When you have completed the calibration procedure click the
Exit button on the Speaker calibration page, or the Off
button on the product, to fetch the calibration settings from the
controller.
The calibration settings will be shown in the speaker list on the
Speaker calibration page.

• Click the Start button.
• Click the Next link in the Breadcrumb Trail to proceed to the
next page.
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Advanced tips
Specifying the serial port
• Click the Options… button on the Pre-calibration store page
to display the Comms Port tab on the Options dialogue box:

• Select the port you want to use from the drop-down list and click
the OK button.
A warning triangle will be displayed against the port number if it is
already in use by another program.
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Room correction
The Room correction page runs the Meridian Room Correction
procedure. This is optional and you can skip this stage by clicking
the Next link in the Breadcrumb Trail:

For information about running the Room Correction procedure see
the chapter Room Correction, page 31.
• Click the Next link in the Breadcrumb Trail to proceed to the
next page.

Quick tour
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DSP presets
The DSP presets page shows a list of the DSP presets available to

For a simple configuration you can skip this page.

the digital surround controller, and allows you to edit the properties
of each preset. You can also edit the preset mappings, to change
the default DSP preset selected for each source and each audio

• Click the Next link in the Breadcrumb Trail to proceed to the
next page.

format.

Advanced tips
The Preset Properties pane shows the name and value of each
of the preset properties:

Creating user-defined presets
You can create additional user-defined presets with specific
properties:
• Right-click the preset you want to use as the basis for the new
preset, point to Copy to on the context menu, then click New
Preset on the submenu:

If you have already created one or more user-defined presets, you
also have the option of overwriting an existing user-defined preset.
Restoring presets to their default values
Some properties apply globally to all presets; to edit these select
All presets in the Preset Properties list.

• Right-click the preset, then click Revert to Defaults on the
context menu:

Displaying and changing the properties for a preset
• Select the preset in the left-hand list.
You can then edit the properties in exactly the same way as for
product properties; see Changing the value of a property, page 9,
or Reverting a property to its default value, page 9.
For full information about the parameters for each DSP preset see
the Installation Guide for your product.

• Alternatively click Revert All to Defaults… to revert all the
built-in and user-defined presets to their default properties.
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Changing the preset mapping
The Preset Mapping pane shows the default DSP preset selected
for each source and each audio format.
• Click the preset in the appropriate audio format column and
select the preset you want to use for the default from the dropdown list:
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Tuner presets
For each product in your system that includes a radio tuner, a
Tuner presets page allows you to define the legend displayed on
the front panel display for each tuner preset, and the waveband,
frequency, and audio mode it selects:

• Click the checkbox in the Number column to enable the
corresponding tuner preset, and edit the Legend, Frequency,
and Audio Mode as required.
• Set Display Legend to No if you want the display to show
the RDS station name, or frequency if no RDS station name is
available, rather than a predefined legend.
When you have edited the tuner presets as required:
• Click the Next link in the Breadcrumb Trail to proceed to the
next page.
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Store settings
This page stores the settings to the controller:

• Connect the serial cable.
For more information see To connect the serial cable, page 23.
• Click the Start button to store the settings.
When the store has completed:
• Click the Next link in the Breadcrumb Trail.

Quick tour
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Finish
The Finish page confirms that you have successfully completed the
configuration of your system.

Save a copy of your configuration
Although a copy of the configuration document is saved in the
controller for your system, it is recommended that you also save
a copy of the final configuration document on your PC, with an
appropriate name, so that you can refer to it again at a later date,
if necessary.
• On the File menu, click Save, or click the Save button in the
toolbar:
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Room Correction
The G68 and 861 digital surround controllers incorporate room correction, which takes
advantage of advanced digital signal processing techniques to compensate for room artefacts,
including resonances and reflections, to give a significant improvement in the sound.
This chapter explains how to use Meridian Room Correction to create profiles for use with the
digital surround controller.

Introduction
The Meridian Room Correction procedure creates a set of one or

How room correction profiles are
calculated

more room correction profiles matched to your room. These are then

Calculating a room correction profile is a time-consuming and

downloaded to the digital surround controller and can be associated

mathematically complicated process. Meridian Room Correction

with particular presets, or selected from the front panel. Selecting a

performs the necessary sequence of measurements and calculations

profile applies a set of digital filters individually to each speaker to

automatically, using a PC connected to the digital surround

achieve the required room correction.

controller, with the minimum of interaction. It works as follows:

If you use a single speaker layout you may choose to have one

First you need to set up a microphone close to the listening

room correction profile, and use this with all presets. If you have

position, and connect this to an appropriate input on the digital

separate speaker layouts for use with Music, Logic, and 5.1 Movie

surround controller. On the G68 Digital Surround Controller this will

sources you will need to calculate a separate room correction profile

be A8 (L). On the 861 Reference Digital Surround Controller this can

for each speaker layout. These will then be selected automatically

be any analogue input; input A1 on card IA00 is chosen by default.

by the digital surround controller depending on the audio format. In
addition, you can create separate room correction profiles to take

Usually a standard sound pressure level meter will be used as a

account of changes to the room, such as the position of large items

microphone; this can be the same one used for setting the speaker

of furniture, or with curtains open or closed.

levels during the Calibration procedure. After an initial short test
sequence, designed to check that the microphone is set up correctly,
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a test signal is presented to each loudspeaker and measured at the

Unless your listening room has been specially designed for acoustic

microphone to determine how the room response affects the sound

performance, you will almost certainly hear distinct benefits after

from each speaker. This stage of the procedure takes about one

incorporating room correction into your digital surround controller,

minute per speaker, and can be left to run unattended.

and if the room has major resonances or imbalances the difference
should be quite dramatic.

Finally, after a complete set of measurements has been made
for each channel and speaker layout, the program calculates a

You can find more information about the theory behind Meridian

set of filters for each channel, and stores these to the digital

Room Correction on the Meridian Web Site at:

surround controller. A copy of the measurements, together with the

http://www.meridian-audio.com/p_rc.htm

calculated filters in each profile, is also stored on the PC so they
can be accessed at a later date if required.

Examples
Most domestic rooms tend to be rectangular, or at the very least
have one pair of parallel facing walls, and unfortunately these are
the ideal conditions for low frequency resonances within the room.
The wavelength of low frequency sounds is relatively large, so even
bookcases and curtains act as an almost perfect mirror for low
frequencies.
Frequencies close to the resonant frequency, determined by the
distance between the two reflective surfaces, will sound louder and
take longer to decay than other frequencies. In practice this means
that when listening to music some notes will sound louder, giving a
roughness or unevenness to the sound.
Other problems that can be corrected by room correction are
imbalances between the speakers due to positioning constraints.
For example, in an L-shaped room one loudspeaker may need to be
close to the wall whereas its partner is in an open area, giving rise
to an imbalanced sound field.

33

Room

Auto Build

correction

This section explains how to create a basic room correction using

To set up the room correction options

default settings.

The first step is to specify options for the room correction
procedure.

The room should be as you would normally use it for listening.
Close/open doors, close/open curtains, and position your screen
and furniture as they would normally be for listening.

• Click the Options… button to display the room correction
options:

If you are creating room correction profiles as part of the initial
configuration of your system, follow the procedure described in
this chapter when you get to the Room correction page in the
sequence of Meridian Configuration Program pages.
If you decided not to create room correction profiles when you
first configured the system, start from the saved configuration
file, or fetch the configuration from the digital surround controller,
and then step forward to the Room correction page in the
Breadcrumb Trail:

• Specify the sensitivity for the microphone.
When first running room correction it is recommended that you
leave this at its initial setting.
If you are using an 861 Reference Digital Surround Controller you
will also need to specify the card and input you are using for the
microphone.
• Specify the maximum number of measurement retries; by default
this is set to 3, but you can enter a lower value to reduce the
time taken by retries.
• Click the OK button to confirm the options you have specified.
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• If you are using a G68 Digital Surround Controller connect the
SPL meter or microphone to the analogue input A8 (L).

The Room correction page shows information about each test
and a progress bar indicates the percentage completed:

• If you are using an 861 Reference Digital Surround Controller
connect the SPL meter or microphone to the analogue input you
specified in the Options dialogue box.
• Position the SPL meter or microphone at the listening position
and, if you are using an SPL meter, switch it on.
When using an SPL meter, the C weighting must be used. The 90dB
range is recommended unless the loudspeakers measured less than
75dB SPL during the calibration, in which case the 80dB range is
recommended.
To run the Auto Build procedure
• Click the Start… button.
A countdown dialogue box will give you time to leave the room:

When the measurements have been completed the following
dialogue box allows you to apply the room correction profiles:

A test tone will then be presented to each loudspeaker in turn
for each of the distinct layouts defined in the digital surround
controller configuration file.

• Click the Yes button to assign an appropriate profile to each
preset.

Depending on the number of channels and layouts in your
configuration this may involve up to 24 tests and take up to 20
minutes to complete.
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Each preset will be assigned the profile designed for the layout
used with the preset. The wizard creates profiles called Mus, Log,
and Mov for the Music, Logic, and 5.1 Movie speaker layouts
respectively. If two or more layouts share the same settings, the
profile name will include all the layouts it applies to; for example,
MusLog or MusLogMov.

What next?
You have now completed the Auto Build procedure, which creates
a recommended set of room correction profiles. In most situations
this is all you need to do in order to take advantage of room
correction with your digital surround controller.
The next sections describe some of the more advanced options
available on the Room correction page, including the options
for re-measuring channels, selecting different filter parameters, and
manually editing the filters.
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Viewing and repeating measurements
The Measurements tab shows a list of the measurement sets you
have created. Each measurement set shows the channels measured
for each of the speaker layouts set up in the digital surround
controller configuration:

You can also create additional measurement sets; for example to
cater for different furniture layouts. For each measurement you can
view the effect of applying different profiles.
• Select the profile from the Profile drop-down list.
The Measurements tab gives you the option of viewing
or comparing the measurements. You can also repeat the

To show the uncorrected response select Bypassed.

measurements for individual speakers; for example, if an external
noise interfered with the test procedure.

You can compare the effect of two Profile settings on the same
plot by clicking one of the split pane buttons:

To view the measurements
• Right-click the measurement you want to view, then click View
Plot on the context menu, or double-click the measurement:

The Plot Measurement window allows you to see the
measurement for the specified channel:
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You can then set different Profile settings for each plot:

Shows the response of the room to a series of short sine wave
pulses of frequencies between 0 and 250Hz. It shows how the
response decays over time at each of those frequencies.
The ideal waterfall plot would have a smooth profile and decay
evenly to a low level within 0.5 to 0.8 seconds. Peaks or dips
in the waterfall plot indicate resonances or absorption at the
corresponding frequency. Ridges extending forwards in time
indicate reverberation at the corresponding frequency.
The room correction profile aims to identify the strongest
resonances and to reduce the decay time of each strong resonance
to the average decay time for the room.
Impulse response

You can select one of the following three graph types by clicking
the corresponding tab. All three views of the measurement are
calculated from the same measured test signal:
Waterfall plot

Shows the response over time of the loudspeaker to a click. The
curve shows a maximum just after time zero, and then decays
rapidly depending on the amount of reverberation in the room. Any
additional peaks in the response indicate resonances set up by the
initial impulse.
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Low frequency response

In the Waterfall Plot the values displayed correspond to Time = 0.
To change the axes
• Click the Axes… button to display the axis parameters.
The Data Range section on each tab shows the range of the data
measured by the Room Correction procedure.
The View Range section on each tab allows you to set the range
of the Frequency, Level, Time, and Amplitude axes as appropriate
for each plot:

Shows the loudspeaker-room response to a low frequency sine
wave, swept between 0 and 250Hz. The ideal low frequency
response would be smooth. A peak in the response indicates a
resonance at the corresponding frequency. A dip in the response
indicates absorption or cancellation at the corresponding frequency.

To repeat measurements
You can repeat measurements for one or more channels;

To display the value of the curve at any point

for example, if an external sound interfered with an existing

• Drag to position the vertical red cursor.

measurement.

The values of the curve at the current point are displayed in the top

• Right-click the measurement you want to repeat, then click Re-

right-hand corner of the plot:

measure… on the context menu:
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The following dialogue box allows you to select which channels

To create multiple measurements

you want to repeat:

You can create additional measurement sets to take account of
different configurations of the room, such as with curtains open or
closed.
• Right-click the Measurements tab, then click New on the
context menu.
A new measurement set will be added to the list, and the
Speakers to Measure dialogue box will be displayed to allow
you to specify which speakers you want to measure.

• Select the channels you want to repeat.
• Click the OK button to confirm your selection.
The following dialogue box warns you that the existing
measurements will be overwritten:

• Click the OK button to proceed with the measurement.
To rename a measurement set
• Right-click the measurement set, then click Rename on the
context menu, or press 2.
• Edit the name as required and press R.
To delete a measurement set
• Right-click the measurement set, then click Delete on the
context menu, or select the measurement set and press D.

• Click the Yes button to continue, or the No button to retain the
existing measurements.
The following dialogue box then indicates how long the selected
measurements will take, and gives you an opportunity to leave the
room before the test sequence begins:
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Viewing profiles
The Profiles tab shows a list of the profiles that have been

• Click the OK button to continue.

calculated, together with the number of filters used for each profile
and the number of remaining filters available:

If you have more than one measurement set the following dialogue
box is displayed to allow you to select which measurement set you
want to use for the filters:

Each profile can use up to 60 filters; if a profile requires more
filters than this, filters will be allocated in order of priority.
Each channel is limited to a maximum of 20 filters; a two-channel
system therefore has a limit of 40 filters.
To build the filters for a profile
• Right-click the profile in the Profiles list, then click Build… on
the context menu:

Note: The process of building filters is computationally intensive,
and it is recommended that you do not try to run other programs
at the same time.
As the filters are calculated the status is shown in the lower half of
the Room correction page.
To store profiles temporarily to the digital surround
controller

The following dialogue box then allows you to specify a target

You can store profiles temporarily to the digital surround controller

decay time:

so you can listen to them while using Meridian Room Correction.
• Right-click the profile in the Profiles list, then click Store on the
context menu.
The lower half of the Room correction page shows the progress

• Leave Automatic selected, or click Manual and enter a delay
time between 100 and 1000 milliseconds.

as the profile is stored to the digital surround controller.
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After building the filters for a profile you can edit the filters

The columns give the Centre Frequency (Hz), Gain (dB), Filter

numerically or graphically to adjust their parameters, or change the

Bandwidth (Hz), Room Mode Bandwidth (Hz), Equalized Bandwidth

response of each filter.

(Hz), RT60 (s), Target RT60 (s), and Channel:

Note: This should only be attempted by users with an
understanding of filter design. It is strongly recommended that you
copy the profile first and then edit the copied profile. There is no
undo function within Edit filters.
To display the filters for a profile
• Right-click the profile in the Profiles list, then click Edit… on
the context menu, or double-click the profile in the Profiles list.
The Edit Filters window shows a numeric or graphical display of
the filters in the profile.
• Choose a channel from the Channel drop-down list to display
the filters for that channel, or choose All Channels to show all
the filters for all channels on a single display.
To view the filters numerically
• Select Numeric.

The fields on the left of the filters list allow you to adjust the
Frequency, Gain, and Width of the currently selected filter.
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To view the filters graphically

The currently selected filter is displayed with a red vertical bar

• Select Graphical:

at the filter centre frequency, and a rectangle indicating the
bandwidth and gain of the filter.
You can edit each parameter of the filter interactively as described
in the following sections.
Centre frequency
• Drag the vertical bar to the left or right on the filter response
curve, or press < or >:

To edit a filter
• Select the filter you want to edit by clicking on the filter:
Gain
• Drag the base of the filter, or press ^ or V:

Alternatively if the filters are close together you can step right or
left between filters using cT or cST.
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Bandwidth
• Drag one of the sides of the filter, or press c< or c>:

To add a filter
• Click the Add button on the Numeric or Graphical tab:

• Edit the parameters of the filter as described above.
To delete a filter
• Select the filter you want to delete in the Filters list, or on the
Graphical tab.
• Press D, or click the Delete button:
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Changing settings at a later date
This section describes how to change the room correction or

To change other settings if you have the original MSL file

configuration settings of the digital surround controller at a later

• Run the Meridian Configuration Program and open the original

date, subsequent to storing the original version.
Note: You can only edit or add to existing profiles if you have the

MSL file.
If you want to keep the original settings:

MSL file originally used to design the profile. If you do not have the
original MSL file you will need to make new measurements, create
new profiles, and then store these to the digital surround controller.

• On the File menu, click Save as to save a copy of the MSL file
under a new name.
• Change the settings as required and store the new settings to

To edit an existing profile, or add a new profile

the digital surround controller.

• Run the Meridian Configuration Program and open the MSL file
used to create the original profiles.

For more information about changing configuration settings using
the Meridian Configuration Program refer to the Installation Guide

If you have changed settings on the digital surround controller

for your product.

since the original profiles were made, and you want to retain these
changes:

To change other settings if you have lost the original MSL

• On the File menu, click Save as to save the MSL file under a

If the original MSL file is not available you will be able to change

file
new name.

all non-room correction settings, and which room correction profile
you want to use with a given preset.

To fetch the settings from the digital surround controller:
• Start a new document.
• On the Products page, right-click the controller, then click
Fetch… on the context menu.

• On the File menu, click Fetch to fetch the settings from the
digital surround controller.

• Step forward to the Room correction page in the Breadcrumb
Trail.
• Select the Profiles tab, and proceed as described in Editing

filters, page 41.

The newly created file will contain the profile labels and these can
be used to choose the profile you want to use with a given preset.
It will not contain measurements or profile data for Meridian Room
Correction. If you use Meridian Room Correction to create new
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measurements and profiles and store these to the digital surround
controller, the old profiles will be overwritten.
• Change the settings as required and store the new settings to
the digital surround controller.
For more information about changing configuration settings using
the Meridian Configuration Program refer to the Installation Guide
for your product.
To change other settings directly on the digital surround
controller
For information about changing other configuration settings on the
digital surround controller refer to the Installation Guide for your
product.
After making changes on the digital surround controller you can
add these changes to an existing MSL file as follows:
• Run the Meridian Configuration Program and open the original
MSL file.
• On the Products page, right-click the controller, then click
Fetch… on the context menu to fetch the new settings from the
digital surround controller.
If you want to keep the original settings:
• On the File menu, click Save as to save a copy of the MSL file.
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Troubleshooting
This section gives suggested solutions to typical problems that
may occur when using Meridian Room Correction. If problems

• Check that the SPL meter is switched on and set to the 90dB
band, or the band which includes 90dB, and with C weighting.

still persist after working through the following steps please send
an email to support@meridian.co.uk with a zip file containing

If the loudspeakers measured less than 75dB SPL during the

your MSL file. Please also supply details of the loudspeakers and

calibration phase it may be better to use the 80dB range.

amplifiers you are using.
• Check that the lead from the SPL meter is connected to the
Failed microphone/SPL meter test
During the first measurement a microphone test is performed
to ensure that the power and SNR (signal to noise ratio) are
acceptable. The larger the SNR the better the measurement.

correct input,
A8 (L) on the G68.
• Ensure that the Sensitivity setting is adequate for the SPL meter
or microphone.

The following sections describe some of the most likely problems

The sensitivity value for analogue inputs is given in rms volts

which will cause the power and SNR values to go outside these

(Vrms). For example, a sensitivity of 1Vrms allows a signal of

ranges.

2.8Vpp. A sensitivity of 1V is recommended for use with most SPL
meters though 0.7V may be preferable for those with lower level

Power result “Bad”

output.

This indicates that there is very little or no signal on the connector
you have chosen as your microphone input.

Power OK, SNR result “Bad”
The most likely cause of this problem is that an analogue source is

• Check that there was sound from the front left speaker during

connected to the input chosen for the microphone.

the test.
• Check that the lead from the SPL meter is connected to the input
If in doubt, repeat the measurement. If there is still no sound check

you have chosen for the microphone test.

the connections from the digital surround controller to the left
loudspeaker. Switch the digital surround controller off and then

Another possibility is that the lead from the SPL meter is in bad

on again, select Calibrate as described in the installation guide

condition and only making a poor connection.

for your digital surround controller, and check that the left speaker
plays the calibration signal.

Power OK, SNR result “Poor”
The reasons for this are described in detail in the following section

• Ensure that the lead from the SPL meter is intact.

where example measurements are also shown.
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Repeated measurements due to poor SNR

SPL meter is set on a low band

Measurements are retried until the SNR is acceptable or the

The following graph shows an impulse response obtained when a

maximum number of retries has been completed. The maximum

Radio Shack SPL meter was set on the 60dB band. The SNR value

number of times each measurement will be retried due to poor

was “Poor”:

SNR can be set in the Preferences dialogue box, accessed from
the Options menu:

SPL meter is set on a high band
The default number of retries is 3. If the measurements are

The following graph shows an impulse response obtained when a

consistently giving poor SNR figures you can reduce the number of

Radio Shack SPL meter was set on the 120dB band. The tail of the

retries. However, it is better to follow the steps described below to

response is generally noisy. The SNR value was acceptable but the

improve the measurement conditions. The better the measurement

power was “Bad”:

the more accurate the results when calculating the filters for a
profile.
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Loudspeaker is running in a non-linear range

Hum in the system

The effects of a loudspeaker running in a non-linear range is most

The effect of hum on the measurement is most easily observed in

easily observed in the impulse response. The tail of the response

the waterfall plot. The continuing signal at 50Hz and 150Hz in the

has small spikes, as shown in the plot below, where it should be

waterfall plot shown below indicates a mains hum loop:

zero. The larger these spikes are relative to the largest value at the
beginning of the impulse response the smaller the SNR value:

You are likely to have heard this level of hum when playing
analogue sources connected to the same analogue input card as
the microphone/SPL meter.
In order to get a better measurement disconnect analogue sources
• Check that the bass protection size has been correctly set – see
the Installation Guide for your product.
• Check that the bass drive unit in your loudspeaker is not rubbing.

from the analogue input card used for the room correction
measurements. Reorganise your speaker wiring to remove the hum
loop.

• Check that your amplifier is not clipping.
Hum may also be picked up by the lead from the microphone/SPL
If problems are still encountered, use the Speaker calibration

meter. It is best to use a shielded cable to reduce the chances of

page to reduce the gain of the channel. Use the reduced gain

picking up hum.

setting for the room correction measurements, then return to the
correct level for a calibrated system after running room correction
measurements.
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Control Window
The Meridian Control Window emulates an MSR+ to allow you to control a Meridian product
from a PC via a serial or USB cable.

Running the Meridian Control
Window

The Meridian Control Window will be displayed:

• Click Start, point to Programs, Meridian, then click Control
Window:

This provides the following tabs:
Tab

Description

MSR+

Emulates an MSR+ Controller.

MSR

Emulates an MSR Controller.

Command

Allows you to send predefined commands, and
optionally specify arguments for the commands,
and then see the response from the product in a
terminal-style window.
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Emulating an MSR+ or MSR
To send a command to the product

A tooltip shows the description of the key followed by the key’s

• Click the corresponding button on the Control Window.

command:

The bar above the buttons shows the response from the product,
corresponding to the front panel display.
To enter a function key

Either:
• Click the Fn button followed by the button you want to enter.

Or:
• Right-click the button or click the button while holding down
c.
The legends of the buttons change to show the function options.

You can also give commands by typing the key’s command on the
computer keyboard. Note: Commands are case sensitive.
For example, to select the CD source type CD.
In addition, the following keys on the keyboard provide shortcuts
for the menu buttons:
Computer key

MSR button

^, V, <, >

A, V, <, >

R

Enter

b (backspace)

Return

To lock the Fn button down
• Click the Lock button:

To disconnect the Control Window
• Click the Disconnect button.

Subsequent button presses will then enter function keys.

To connect the Control Window
• Select the COM port you want to use from the Port drop-down

Press the Lock button or Fn button again to release the Lock

list.

button.

• Click the Connect button.

To see the command corresponding to each button

A warning triangle next to a port number indicates that it is in use

Each button transmits a two-letter code to the product.

by another application.

• Point to the button with the mouse pointer.

To close the Control Window
• Click the Close button or press E.
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Using the Command tab
The Command tab lists all the available commands under four

Window
• Enter the argument from the keyboard:

headings: Source, General, Function + MSR keys, and Preset:

• Click the Send button, or press R, to enter the command.
To display the commands
• Click the + button to the left of one of the headings to show the
commands under that heading.
• Double-click the command you want to send.
To send a command with arguments
• Click the command in the Command list.
You will be prompted for the argument in the box below the
Command list.
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